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Introduction 

Overview 
With FTR Reporter™ you can record audio and video, and annotate court, conferences, hearings, or meetings 

from a single program that automatically links the annotations to the exact time at which events occurred.  FTR 
Reporter is ThinkLink enabled and TheRecord Empowered.  Using the companion ThinkLink enabled programs – 

FTR Player and FTR Log Notes – you can quickly and efficiently review your recordings and annotations. 

When a program is TheRecord Empowered, it creates recordings that utilize a patented FTR file naming 

technology.  This file naming technology is then used by ThinkLink enabled programs to maintain an association 

between the recording and other data that links to the recording. 

FTR Manager is installed with FTR Reporter. This guide covers all the features of FTR Reporter. 

About This Guide 
This User’s Guide assumes that you are familiar with Microsoft Windows operating systems.  If you are new to 

Windows, make use of the extensive Windows help system before attempting to use FTR Reporter. 
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FTR Reporter 

Getting Started 

Installation 
FTR Reporter is installed as a component of FTR Recording Suite.  Refer to the Setup Guide that accompanies 
FTR Recording Suite. When installation is complete, be sure to set General Options, Recording Options and 

Archiving Options to suit the way you work.  See Configuring FTR Reporter later in this guide. 

Note:  Log in as a member of the local Administrators group, to change Administration, Recording, and Archiving 

options.   For details on how to configure the program see Configuring FTR Reporter later in this guide. 

Licensing 
FTR Reporter requires one of the following license types: 

• Trial evaluation 14 days 

• Machine license – permits the use of Recording Suite on this machine only. 

• Site license – permits the use of Recording Suite on all machines on this site. 

Either a machine or a site license may have been activated during setup and no further licensing action is 

required. If a 14-day trial evaluation license was chosen, to continue to use FTR Recording Suite beyond the end 

of the trial period, you must activate either a machine license or a site license. 

License your copy of Recording Suite by displaying the About dialog and pressing Activate. 

 

  

http://www.fortherecord.com/


 
 

 

 
 
 

Page 3 
© FTR Pty Ltd, 2021. All Rights Reserved. 

For more information visit www.fortherecord.com 

 

FTR Reporter 

Activate License 

Use the License Activation page to select your appropriate license. 

 

 

 

Choose the first option to license this machine only: 
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FTR Reporter 

On completing Step 1, you will receive a registration file. Email it to licensing@fortherecord.com in order to 

receive your license key. 

 

Use the license key to complete Step 2. 
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FTR Reporter 

Choose the second option if you have a site license: 
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FTR Reporter 

When your license has been successfully activated: 
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FTR Reporter 

Starting 
You can start FTR Reporter from the desktop, or depending on your operating system, from the Start menu or 

Apps screen.  

To start FTR Reporter: 

1. From the desktop, double-click the FTR Reporter icon  or 

2. Observe that the program starts.  

Note:  On first startup, FTR Reporter does not show the Level history bar or Log Sheet Pane.  

See Working Environment for details on how to show/hide these areas. 

 

3. Create a new log sheet, as required.  See later in this guide. 

4. Start, pause and stop (conclude) recording, as required.  See Recording and Monitoring later in this guide. 

About FTR Reporter 
The About box lists information about your installation, including license validity (refer to Licensing above for 

details). 

To display the About box:  

1. Do one of the following: 

a. Double-click the FTR Gold logo at the top left corner of the main window or  

b. Click the Menu button , point to Help and click About FTR Reporter. 

2. View the information in the About FTR Reporter dialog box. 

3. Click OK to close the About box. 
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FTR Reporter 

Help 
The following help resources are available: 

• FTR Recording Suite Setup Guide 

• FTR Reporter User Guide (this Guide) 

Viewing the Setup Guide 

The Setup Guide is published in Portable Document Format (PDF) and will be available with the purchase of FTR 

Gold Recording Suite. 

Note:  The Setup Guide requires Adobe® Reader®.   

Viewing the User Guide 

The User Guide PDF is displayed when you click on . 

System Information 

System information is saved in a collection of text files that are stored in a zip file on your desktop and copied to 

your clipboard.  When system information is saved you can view the text files using the text viewer of your choice 

and you can send them to customer support as required. 

To save system information: 

4. Click the Menu button  , point to Help and click About FTR Log Notes. 

5. From the About FTR Reporter dialog box, click the System Info… button. 

6. Observe a progress dialog box as system information is being saved. 

7. When complete, a message box confirms that saving was successful, and that system information is available 

from the desktop. 

To view system information: 

8. Save system information as described above. 

9. From your desktop, double-click the FTR System Information... zip folder. 

10. From Explorer double-click the text file you wish to view. 

To send System Information: 

11. Save system information as described above. 

12. From your desktop, right-click the FTR System Information... zip folder, point to Send To and click Mail 

Recipient.  Enter the email address for your support team and send the attached system information files. 
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FTR Reporter 

Programmers Reference 
When FTR Reporter is installed there is an option to include Visual Basic for Applications.  If this option is 

selected the VBA Editor and Programmers Reference are available to customize the way FTR Reporter works. 

To start the VBA Editor: 

1. Click Start, point to All Programs, ForTheRecord then SDK. 

2. Click Visual Basic Editor. 

3. Use the VBA Help and the Programmers Reference to customize FTR Reporter. 

To view the Programmers Reference: 

1. Click Start, point to All Programs, ForTheRecord then SDK. 

2. Click Programmers Reference. 
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FTR Reporter 

Working Environment 
This section of the guide describes the main components of the FTR Reporter window. 

 

 

 

 

 

 

 

  

Compact player - docked Level History Tool bar Recorder bar 

Log Sheet Pane  Status bar 
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FTR Reporter 

      

Menu 

To open the menu, click the Menu button  or press Alt. 

 

This section of the user's guide describes each menu. 

File Menu 

The File menu contains the following commands:  

Function Description 

New… Creates a new log sheet that is based on template.  

Continue From Creates a new log sheet that is based on the active log sheet.  

Open… Opens an existing log sheet.  

Search… Opens the Search dialog box.  Use this dialog box to enter search criteria so that you can quickly find the 
required log sheet.  

Close Closes the active log sheet.  

Save Copy As Saves a copy of the active log sheet to another location.  Also allows you to save as HTML. 

Page Setup… Opens the page setup dialog box where you can specify the layout for printed log sheets.  

Print Preview Shows how the active log sheet will be printed.  

Print… Opens the Print dialog box where you can choose how much is printed.  

Properties Displays the file name and path of the active log sheet. 

Most recent list Shows the nine most recently opened log sheets.  You can select any one of these to open.  

Exit Quits the program.  

Edit Menu 

The Edit menu contains the following commands: 

Function Description 

Undo Undo last changes.  

Redo Redo last changes that you have recently undone.  

Edit Mode Switches the log sheet between read-only and editable.  

Format… Opens the format dialog box where you can specify bold, italics, underline and color options.  

Cut Cuts the selected text from the log sheet and places it on the clipboard.  

Copy Copies the selected text from the log sheet and places it on the clipboard.  

Paste Pastes the contents of the clipboard to the insertion point indicated by the cursor position in the log sheet.  

Delete Note Deletes the current log note 

Find… Opens the Find Text dialog box where you specify what text you want to find in the active log sheet.  

Find Next Repeats the find action using the previous find text.  

Synchronize Note Sets the timestamp of the active log note to match the time of the associated content currently open in the 
player.  

Synchronize Sheet Sets the timestamp of the active log note to match the time of the associated content currently open in the 
player and then adjusts all other timestamps by the same amount.  
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FTR Reporter 

View Menu 

The View menu contains the following commands: 

Function Description 

Touch View 

Shows a magnified view of Start, Stop, and Seal buttons which are touch-sensitive if using a touch screen. The 
Clock, Record Channels, and Inputs displays are also magnified. For Touch View, we recommend you set the 

display resolution to 1600x900 and scaling to 125%. 

    

 

Level History Shows or hides the level history bar.  

Log Sheet Pane Available when there are no log sheets open.  Click to hide the empty log sheet pane.  

Record Time 
Window 

Displays the recording time in a separate re-sizable window.  

Record Level 
Window 

Displays the recording levels in a separate re-sizable window.  

Input Level Window Displays the input levels in a separate re-sizable window. 

Always On Top If selected ensures that the FTR Reporter window is always on top of other programs.  

Actions Menu 

The Actions menu contains the following items: 

Function Description 

Link Click to set the play time in player to match the timestamp of the current log note. 
Note:  This action is usually performed by clicking the timestamp.  

Set Range Start Sets the range start time in the player to match the timestamp of the current log note.  

Set Range End Sets the range end time in the player to match the timestamp of the current log note.  

Tools Menu 

The Tools menu contains the following items: 

Function Description 

Spelling Starts the spell checker.  See Spell Checking later in this guide.  

Quick Notes Opens the Quick Notes window.  See Quick Notes later in this guide 

Word List Shows or hides the word list window.  See Using The Word List later in this guide.  

Templates Opens the Templates dialog box where you can add, edit or delete templates.  See Managing Templates later 
in this guide.  

Tag Hearing Start Inserts a tagged note that identifies when a hearing starts.   

Tag Hearing Stop Inserts a tagged note that identifies when a hearing stops.    

Merge  Provides a way to merge multiple log sheets into one while maintaining the originals. 

Filter Provides a way to extract specific notes from a log sheet to create a new log sheet. 

Options Opens a cascading menu of options that control how the program behaves.  See Configuring FTR Reporter later 
in this guide.  
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FTR Reporter 

Record Menu 

The Record menu contains the following items: 

Function Description 

Start or Pause Starts or pauses recording.  

Note: Your court system may require you to specify a save destination for recordings. If so, the following 
dialog will appear, requiring you to select a Destination each time you start a recording: 

 

For further information about the recording save destination, please refer to General Options, 
Administration Tab on page 28. 

Stop and Conclude Concludes recording. 

Play At End Starts Player (if not already started) and loads the active recording (if available) - Confidence Monitoring.  

Switch to Sealed (or 
Public) 

Switches between sealed and public recording. 

Archive Available if the archive options are set to CD/DVD or Removable disk.  Click to start archiving.  

Window Menu 

The Window menu shows a list of open log sheets from which you can select one to become the active log sheet.  

If more than nine log sheets are open, the More command is available.  Click More to view the complete list. 

To activate a different log sheet: 

1. Click the Menu button  and point to Window. 

2. Do one of the following: 

a. Click the log sheet you want to activate or 

b. Click More.  From the Activate dialog box click the required log sheet and click OK. 

Help Menu 

The Help menu contains the following items: 

Function Description 

FTR Reporter Help Opens the main help. 

About FTR Reporter Opens the About dialog box, which shows version information and trademark attributions. 
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FTR Reporter 

Toolbar 
The toolbar contains buttons providing quick mouse access to the main FTR Reporter functions. 

 

Icon Function Action 

 
Menu Click to open the main menu. 

 
New Creates a new log sheet. 

 
Most Recent Click to open the Most Recent log sheet list.  You can select any one of these to open. 

 
Search Locate a log sheet based on defined search criteria 

 
Save Copy As 

Opens the Save Copy As dialog box, which is used to save a copy of the log sheet to another 
location. 

 
Print Click this button to print. 

 
Print Preview Preview the active log sheet before printing 

 
Edit/Read-only Toggles between edit mode and read-only mode.  Click to enable or disable log note editing. 

 
Find Text Opens the Find Text dialog box, which is used to locate specific words in the log sheet. 

 
Spelling Start the spell checker. 

 
Quick Notes Open the Quick Notes Window 

 
Word List Open the Word List Window 
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FTR Reporter 

Level History 
 

 

 

 

The level history bar shows up to 12 hours of recording history for each of the recorded channels.  Recording 
history indicates audio activity in the venue and the recording state.  The period of level history is controlled in 

FTR Reporter options.  For more details about how to use the level history bar, see Back Annotating later in this 

guide. 

Each recording channel is represented by a separate bar and the color indicates audio activity as:  

•   Solid black indicates that there is no connection with the recorder. 

•   Solid dark color indicates a connection but no activity in the venue. 

•   Shades of color indicate activity in the venue as various participants speak on different recording 
channels. 

The line through the middle indicates the recording state.  The line is red when recording is in progress. 

The current play time control tab  is shown if the player is currently playing any part of the recording that is 

shown in the level history bar.  It can be dragged to any position where a recording exists.  

Note:  The current play time can also be adjusted directly from FTR Player or by clicking a timestamp.  If the 

current play time is set to a time that is not available in the level history period, it is not shown. 

To view/hide the level history bar: 

1. Click the Menu button , point to View and click Level History. 

2. Observe that the level history bar is displayed in the main window. 

3. Repeat step one to hide the level history bar. 

Enhanced Level History 

If a suitable recording device is installed, you can record up to sixteen channels.  The line representing the 
recording state is in the middle of the Level History Bar.  When configured with an even number of recording 

channels they are symmetrically arranged around the recording status line while odd recording channels are 

distributed from the top, leaving a space at the bottom. 

Channel 1 is always the top row. 

 

Sixteen-channel recording 

  

No connection Connection but no activity Connection with activity 

Not recording Recording 
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Recorder Bar 
Use the Recorder Bar to start and stop recording.  There may be an archive button depending on the chosen 

archive method. 

 

 

Icon Function Description 

  
Start 

Click this button to start recording.  

Note: Your court system may require you to specify a save destination for 
recordings. If so, the following dialog will appear, requiring you to select a 
Destination each time you start a recording: 

 

 

 

For further information about the recording save destination, please refer 
to General Options,  Administration Tab on page 28. 

 

  
Wait Preparing to record. Advisory only. No action required.  

 
Pause Click this button to pause recording. 

 
Resume Click this button to resume recording. 

 
Stop and Conclude 

Click this button to conclude the recording. 

 

 
Play At End Click this button play the latest available recording - Confidence Monitor.  

   
Seal (or Public) Click to switch between sealed and public. 

 or 

 

Record Time Displays the record time.  If sealed, a red border is added. 

 
Record Level 
Display 

Displays peak audio for the highest channel level.  

 or  
Archive 

Starts archiving to CD/DVD or removable disk drive, depending on 
configuration. 

 Location Name 
Displays the location name followed by the abbreviation of the save 
destination.  
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Record Time Window 
Recording time can be displayed in a separate re-sizable window. 

To open the Record Time window: 

1. Do one of the following: 

a. From the Recorder Bar, double-click the Record Time display  or 

b. Click the Menu button , point to View and click Record Time Window. 

 

2. To close the window, click the close button in the top right corner. 

Record Level Window 
Recording level can be displayed in a separate re-sizable window. 

To open the Record Level window: 

1. Do one of the following: 

a. From the Recorder Bar, double-click the Record Level display   or  

b. Click the Menu button , point to View and click Record Level Window. 

2. Observe that the Record Level Window is displayed. 

 

3. To close the window, click the close button in the top right corner. 
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Input Level Window 
Input levels can be displayed in a separate re-sizable window. 

To open the Input Level window: 

1. Click the Menu button , point to View and click Input Level Window. 

2. Observe that the Input Level Window is displayed. 

 

3. To close the window, click the close button in the top right corner. 

4. Observe that the Input Level Window is closed. 
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FTR Reporter 

Log Sheet Pane 

Log sheets are used to annotate events that occur in the recording venue and are displayed in the log sheet 

pane.  If you do not annotate recordings, the log sheet pane can be closed to save desktop space. 

To view/hide the log sheet pane: 

1. Click the Menu button , point to View and click Log Sheet Pane. 

Tip:  If you create or open a log sheet the log sheet pane is automatically opened. 

2. Observe that the log sheet pane is displayed. 

3. To close the log sheet pane, close any log sheets that may be open. 

4. Click the Menu button , point to View and click Log Sheet Pane. 

Note:  If any log sheets are open, the Log Sheet Pane cannot be hidden. 

5. Observe that the log sheet pane is closed. 
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FTR Reporter 

Log Sheet 

A log sheet includes the following components. 

Log Sheet Tab 

• Log Sheet Heading 

• Log Notes 

• Range Bar 

 

 

 

 

 

Log Sheet Tab 

 

Each log sheet opens in a tabbed page and the label displays one of the following titles: 

• First line of the description field or 

• If the Description field is empty, show the Location field or 

• If the Description and Location fields are empty, show the Date. 

One or more of the following status icons may also accompany the title. 

Icon Description 

 The log sheet is associated with the content currently open in player. 

 The log sheet is associated with the recorder 

 The log sheet is read-only and cannot be edited 

 

  

Log Sheet Tab 

Range Bar 

Log Sheet Heading 

Log Notes 
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FTR Reporter 

Log Sheet Heading 

The log sheet heading contains three fields that identify the log sheet.  These are the Description, Date and 

Location fields. 

 

 

The Description Field 

The Description field contains text entered by the user and is commonly used to identify the proceeding.  

This might include a case name, case number, presiding officer and appearances. 

When the Description field is not selected, only the first line of text is displayed.  To expand the field, select 

it or click  to the right.  The field expands to a maximum of ten lines and displays a scroll bar to reveal any 

additional lines that may be hidden.    To close the field, press ENTER or click anywhere outside the field. 

 

 

The Date Field 

The Date field contains the date of the proceedings.  This could be the date of the current recording or the 

date of an existing recording that is open in the player. 

 

The Location Field 

The Location field identifies the venue in which the proceedings occur. 

 

It is the recorder location name and the department of the current recording. 

Note: When user-selectable destination is in use, the location name of a log sheet may not be changed 
because to do so breaks the association between the log sheet and its recording and stops the archival to 

network. 
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FTR Reporter 

Log Notes 

Log Notes are primarily used to describe events that occur during proceedings.  They are organized and 
referenced by a Time column, a Speaker column and a Note column.  Each row represents one time stamped 

log note. 

Note:  The Speaker and Note column titles can be changed. You may have different column titles.  See FTR 
Reporter Options later in this guide. 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 
The table below describes each component of the Notes section. 

Item Description 

Time Field As each log note is created, a time stamp is automatically entered into the time field.  The time field cannot be 
directly edited.  You may adjust timestamps using the synchronize commands. 

Speaker Field Used to identify who is speaking or the type of event that is occurring.   

Note Field Used to add supplementary information to assist those reviewing the matter.  

Row Selector Click this area to select the whole row (and other rows) for printing and saving a copy. 

Scroll Bar The scroll bar is used to navigate the log sheet if it is larger than the current window. 

 

Only the Speaker and Note columns in the log sheet are re-sizable.  

Either column (not both) is resizable to a minimum readable width.  Either column (not both) can also be hidden.  

Should the hidden column contain text then the title bar of the hidden column appears red. 

  

Note field 

Time 
field Speaker 

field 

Row Selector Scroll Bar 

Log note 

Note Column Speaker Column Time Column 
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Range Bar 

The Range bar provides a visual indication that the log sheet is linked to the content currently loaded in the 
player.  The Range Bar is the vertical strip to the left of the log sheet and it shows similar information to that 

displayed on the range bar in the player. 

If the content in the player is linked to the active log sheet, the Range bar shows a blue line that represents all 
loaded content.  A wider shaded area on the line represents the currently selected range in the player and is 

delineated by Range Start and End markers.  The Current Log Note Marker indicates the most recent log note 
that is relevant to the currently playing content in the player.  When the current play time reaches a timestamp in 

the log sheet, the Current Log Note Marker jumps down to the relevant log note. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Current Log Note Marker 
This indicates the most recent log note relevant to the current play time of the linked content.  As the 
content in the player continues to play, the current log note marker moves to show the 

corresponding log note. 

Range Start Marker 
This marker represents the range start time as defined in the Player.  Ranges can be set in player or 
directly from the log note shortcut menu.  See Setting the Audio Range later in this guide for more 

information. 

Content Start 

The top of the thin blue line indicates the start of the linked content. 

Content End 

The bottom of the thin blue line indicates the end of the linked content. 

Range End Marker 
This marker represents the Range end time. 
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Status Bar 
The Status Bar shows information that monitors the status of the archive and backup systems for the recorder. 

 

Item Description 

 or  
Indicates that network archiving is configured and working or there is a problem with archiving.  

 
Icon indicates that the archive method is to CD/DVD. 

 
Icon indicates that the archive method is to removable disk. 

To archive: Shows how much recording is yet to be archived 

Archive space: Shows how much free space is available on the archive drive when configured for network archiving. 

 
If shown, indicates that log sheets are being archived with the recording 

 
If shown, indicates that recordings are also backed up to a separate local disk drive on the recording computer. 

Record Space: Indicates how much free space is available on the disk drive that stores the original recording. 

 

Quick Notes and Word List 
While working with a log sheet you can open separate display windows that show the Word List and available 

Quick Notes.  See Quick Notes and Word List later in this guide for details. 

To open the Quick Notes window, click the Quick Notes button . 
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To open the Word List window, click the Word List button . 
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Configuring FTR Reporter 
You can change the size and position of the FTR Reporter window and you can hide one of the log sheet columns 

as required.  You can also change a number of configuration options to suit the way you work. 

Note:  Log in as a member of the local Administrators group if you want to change, Administration, Recording and 

Archiving options. 

Sizing and Positioning 
When it is not maximized, the FTR Reporter window is re-sizable and can be positioned anywhere on the screen, 

using the re-size handle at the bottom right corner of the window.  You can also show or hide the Level History 

bar and the Log Sheet pane.  See Working Environment – Level History and Log Sheet Pane earlier in this guide. 

Sizing and Hiding Columns 
You can hide or reveal either the Note or Speaker column as required. If there is text in a hidden column, the 
column title appears red. 

 

 

 

 

To change width or hide a column: 

1. In the column title, move the pointer over the border between the Speaker and Note column. 

2. When it changes to a sizing pointer, do one of the following: 

a. Drag the column border to set the required width of the columns. 

b. To hide the column, continue to drag the column border until it collapses to become hidden. 

3. Unhide the column by dragging the border between the hidden column and the visible column.  Keep dragging 

until the column re-appears and set to the required width. 

Note:  When you resize a column, a prompt message is displayed. 

If you answer Yes, the new width and the size is remembered the next time you start FTR Reporter. 

If you answer No, only the active log sheet is affected and the size is not remembered. 
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Changing General Options 
You can also change a number of configuration options to suit the way you work.  Some options are available to 

all users while others are restricted to local Administrators.   

Options are available in the following categories: 

• General – all users 

• Level History – all users 

• Administration – Administrators 

• Loss of Signal Detection – Administrators.  

To change options: 

1. Click the Menu button , point to Tools then Options and click General. 

2. Select the required option page and make changes.  See the following pages for details on each option. 

3. Click OK when all changes are made. 

General Options 

  

• Timestamp offset.  This value specifies how much the time stamp of each new log note is automatically 

adjusted to an earlier time.  The offset value is between 0 and 10 seconds. 
It compensates for the delay that occurs between the actual event and when it is noted.  Different users 
can set the offset value to suit the way they work.  

• Language.  Select the language you wish to use for spell checking. 

• Accessibility.  Select this option to enhance accessibility. 

• Skin. Switch between the Classic and Default user interfaces. Note that the functionality is identical. 
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Level History  

 

• Select the required display period from the list. 

Administration 

These options are restricted - as described at the beginning of this section.  

  

• Show user-selectable destination list on record – If your court system requires you to specify a save 

destination for recordings, a list of destinations will have been configured during setup. Select this checkbox 
to fulfil the requirement through the following dialog: 

 

 
Note: Refer to the Recording Suite Setup Guide for how to configure save destinations. 

• Save recordings in user-selectable destination – This option is only available if the previous option has 
been selected. Select this option if your court system requires the selection of a user-selectable destination 
and uses that selection in the recording save destination folder structure. 
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Note: The following table clarifies the function of these options: 

Show user-selectable destination 

list on record 

Save recordings in user-

selectable destination 

Comment 

X X Both the save destination folder 

structure and the retention 

folder structure use the specified 
destination. 

X  The save destination folder 

structure does not use the 
specified destination. The 

retention folder structure does 
use the specified destination. 

 X N/A 

  Save destination is not user-

selectable. Both save and 

retention folders use the default 
folder structure. 

 

• New log sheet save location – There are two options available. 

› Save with recordings – If selected, all new sheets are saved in a sub-folder of the local recordings 

folder.  Recordings and log sheets will be archived together. 

› Folder - If selected, all new log sheets are saved to the specified folder.  Log sheets are not archived with 
recordings.  This option is generally chosen if you wish to save your log sheets directly to a shared 

network folder - typically a folder on the same computer that stores archived recordings. 

• Template location - Templates store Quick Notes which are specific to a particular case type or 
Department.  They are typically stored on a shared network folder. 

• Column titles - The default column titles are Speaker and Note.  If these are not applicable in your 
organization, enter new titles.  

Loss of Signal Detection 

 

• Log events to the Windows event log – if selected, loss of signal events will be logged to the Windows 
events log. 

• Pop up a message when a channel status changes – if selected, each channel status change causes a 
visible alert. 

• Configure – Click Configure to access Loss of Signal Tuning. 
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Loss of Signal Tuning 

Loss of Signal Tuning is used to configure threshold settings for the detection of a loss of signal.  When the loss 
of signal is detected, a response is generated in the recording program, according to the setting you have 

selected in the Loss of Signal Detection dialog described above.   

The Loss of Signal Tuning Tool first measures ambient input levels.  Then the input levels at each input are 
measured when the channel is switched off or disconnected.  The threshold level is then set to be midway 

between these measured values.  

Note: The Loss of Signal Input feature is only provided to assist with the detection of a failed input.  The only sure 

way to detect a loss of input is to continually perform Confidence Monitoring.  

 

 

To configure threshold settings:  

1. From the Loss of Signal Detection dialog box (see Loss of Signal Detection on page 29), click Configure to 

display the Loss of Signal Tuning dialog. 
2. Select the recorder you wish to tune.  

3. For each input channel you wish to monitor, select the Enable alarm check box.  

4. Click Tune. 

5. The Loss of Signal Tuning Wizard will be activated. Follow the instructions regarding: 

•  Audio system installation and configuration 

•  Venue preparation. 
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6. The ambient levels are measured. 
7. Switch off or disconnect all inputs. 

8. The base levels are measured. 
9. The threshold level for each input is now calculated and set. 

10. Accept the tuning tool conditions and click Finish. 

When Loss of Signal Tuning is complete, the dialog will display the calculated threshold levels for each input 

device. You can manually adjust the threshold levels. 

 

 

 

Note:   If any channels fail the tuning procedure it is probably because the disconnected state 

generates more noise than when the input is connected.   This could be the quality of the cabling, 

the layout of the cabling or some other external factor.  Consult an audio specialist to determine 

the cause. 
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Changing Archive & Backup Options 
There are a number of archiving and backup options that should be established before using FTR Reporter. These 

options are restricted to Administrators or Power Users. 

To change options: 

1. Click the Menu button , point to Tools then Options and click Archive. 

2. Select the Archive and Backup tabs and make changes as required. 

3. When all changes are complete, click OK. 

Archive Options 

From the Archive Options tab you can select one of the following archive methods: 

Network Archiving 

When configured for network archiving the archive process is automatic and requires no end user action. 

 

 

 

• Enter the log on details for an account with read/write permissions to the specified folder. 

• Select Delete immediately after archive to remove the local recordings as soon as they 
are archived. 

Note: Please refer to Setup Guide Gold 7.1 Recording Suite for how to configure the archive 

path. 
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CD/DVD Archiving 

When configured for CD/DVD archiving the archive process is started manually - usually at the end of the day.   

When FTR Reporter is installed to be controlled by FTR Monitor, it is recommended that you do not use the 

CD/DVD archiving method.  The recommended archive method for remote recording is Network Archiving. 

 

 

• Select a suitable CD/DVD device from the list. 

• If you want to archive each days recording to a separate CD/DVD select the One day per 
disc checkbox. 

• Choose a volume label option. 

• Select Delete immediately after archive to remove the local recordings as soon as they 
are archived. 
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Dual Archiving 

When the Dual option is selected you can specify a network folder and an optical drive as your two archive 

locations.  As recording progresses, your local recordings are automatically archived to the specified network 

folder and when recording is stopped you can archive the same recordings to optical disks. 

 

 

 

After selecting the Dual option, it is necessary to run the configuration tool to complete the settings. 

See the instructions on the following pages.  
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To configure Dual Archiving: 

1. From the Archive tab click Dual, then Configure. 

2. From the Welcome page, click Next to continue.  

 

  

3. Observe that the Network Settings page is displayed.  

 

 

4. If the recordings archive folder has restricted access, be sure to enter the log on credentials for an account 

with full access.  Enter the required user name and password. 

5. When all network settings are complete, click Next. 
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6. Observe that the CD/DVD Settings page is displayed. 

 

7. Select the required disc drive from the list of available drives. 

8. If you want to limit each disc to a single day, select One day per disc. 

9. Choose the required Volume label setting. 

10. Click Next. 

11. Check your settings in the summary page. 

12. Click Back to make any changes or click Finish to complete configuration of dual archiving. 

13. Observe that your dual archive settings are now summarized on the Archive options page. 

14. If you want local recordings to be deleted as soon as they are archived to CD/DVD and network, select 

Delete immediately after archive. 

15. When all Dual archive configurations are complete, click OK. 
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Removable Archiving 

When configured to archive to a removable disk drive, the archive process is started manually - usually at end 

of the day.  When you start archiving, you are prompted to choose the removable disk drive.  

When FTR Reporter is installed to operate as a remote recorder, for use with FTR Monitor, it is recommended 

that you do not use this method.  The recommended archive method for remote recording is Network 

Archiving.  

Select Delete immediately after archive to remove the local recordings as soon as they are archived. 
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No Archiving 

Choose this method when you want to use a third party archiving program to archive your recordings and log 

sheets.  

Be sure to configure your third party settings to clear the archive attribute of archived files.  FTR Reporter 

automatically deletes old archived recording files when disk space is low.  If recording files are not marked as 

archived and all free disk space is used, recording stops.   
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Backup Options 

Configuring a backup is intended for users who choose the CD/DVD or Removable Archiving method. 

This ensures that recordings always exist on two physically independent disk drives until archiving is performed. 

Note: Recordings are actually deleted from this location once archiving is successful, 

It can be configured for network archiving for redundancy.  

 

To configure a backup: 

1. Select Create backup copy in: 

2. Select a disk drive from the list. 
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Changing Recording Options 
Before using FTR Reporter for the first time it is important to check that your audio and video recordings options 

are suitably configured.  Most recording options are restricted and can only be changed if you are logged on as a 

member of the local Administrators group.  

Note: Settings can only be changed while NOT recording. 

To change recording options: 

1. Click the Menu button , point to Tools then Options and click Recording. 

2. Make changes to the following options pages as required: 

Location Name 

Audio 

Mixer 

Video 

External Clock 

3. When all changes are made check the Summary page and click OK. 

Recording Options - Location Name 

For most users, the Location Name is established at installation time and cannot be altered.  However, you may 

be able to change the location name if access is enabled at installation time or you are logged on as a local 

Administrator. 
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To change the location name: 

1. Click the drop down arrow to the right of the current location name. 

2. Select the required location name from the list. 

3. If the required location name is not in the list, click Modify list. 

4. From the Location Name dialog box, click New. 

 

5. From the New Location Name dialog box, enter the new name and click OK. 

 

Note: Location Name cannot exceed more than 21 characters. 

6. To edit an existing location name, select it from the list, click Edit, make the changes and click OK. 

7. To remove an item from the list, select it and click Delete. 

8. Note:  The Delete button is not available when there is only one item remaining in the list.  This is because 

there must always be at least one location name. 

9. When all changes are complete, click Close. 

10. To complete the change to the location name, select the new item from the Location Name list. 
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Recording Options – Audio 

Use Audio settings to select and configure your sound devices.   

To configure Audio settings: 

1. Click the Menu button, point to Tools then Options and click Recording. 

2. Click the Audio tab.  

3. Select the required audio capture device from the Sound card list. 

4. Select the appropriate Input for the selected sound card. 

5. If you want FTR Reporter to manage the recording level select the Allow Reporter to... option.  If this is not 

selected you will need to adjust the recording level using the vendor program for your sound card. 

6. Choose the level of compression you want to use from the available Audio Compression settings.  The 

higher the settings the more storage space is required. 
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Recording Options – Mixer 

Use Mixer settings to choose the number of recording channels and to (optionally) assign inputs to record 

channels as required. 

 

To configure mixer settings: 

1. Select the required number of recording channels. 

2. Observe that a list of Current Assignments is displayed that summarizes which inputs are assigned to the 

selected number of recording channels. 

3. If you wish to change the Current Assignments, click the Assign input box to choose the input you wish to 

change and then select the required channel.  When you have made the required selections, click Change. 

4. When all changes are made, click Finish. 
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Recording Options – Video 

Use Video settings to select and configure your video capture devices.  Recording options support the use of up 

to four video sources. 

To configure Video settings: 

1. Click the Menu button, point to Tools, then Options and click Recording. 

2. Click the Video tab.  

3. To record video, select the I want to record video option then configure the required input type. 

4. If your video source is a video card or non-IP camera(s), do the following: 

a. Select the non-IP camera(s) from the list  

b. Choose the required Resolution and Frame Rate 

c. Choose a Preset. Changing the Preset will automatically change the Frame Rate. Preset will be set to 

Custom, if the frame rate does not belong to PAL and NTSC standards. 

d. Choose Compression based on the number of channels and resolution. For multiple channel or High 

Definition recordings our recommendation is that you choose H.264. If your device has onboard H.264 

compression, select “Built-in H.264 compression” option. 

Note: Refer Recording Suite 7.1 setup guide for more information on installing the right codec for H.264. 

e. If video overlay information is required select Show overlay. 

f. Click Verify Non-IP Cameras to validate if the video settings are supported by the non-IP cameras and 

to test the connection to Non-IP cameras.  
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5. If your video source is one or more IP video sources, do the following: 

a. Select IP - Internet Protocol Camera from the list. 

Note: The list of input types may include a vendor specific driver for your IP video source. However, it is 

recommended that you select IP - Internet Protocol Camera.   

b. Enter the RTSP URL for each video source and click Verify IP Cameras to test the connection. 

c. For Onvif, enter IP Address for each video source. If required enter a Username and Password for 

each video source. Click Verify IP Address. 

 

d. Once the IP Address or RTSP URL for each video source is validated, select the required Resolution and 

Frame Rate. The higher the settings, the more storage space required.  

 

6. When all changes are made, click Finish. 
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Recording Options - External Clock 

You can connect and configure an external clock that displays the record time to participants in the venue.  

 

To configure the clock: 

1. Select the Connected checkbox. 

2. Select the COM port that connects to the clock. 

3. Click the Test button and verify that the sample text is displayed by the clock. 
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Changing Sealing Options 

With FTR Reporter you can also switch between sealed and public recording if sealing has been configured in 
Options. To configure sealing options, it is necessary to set your archive options to CD/DVD or Network.  See 

Changing Archive & Backup Options earlier in this guide.  

To change sealing options: 

1. Click the Menu button , point to Tools then Options and click Sealing. 

2. Depending on your Archive Options, observe one of the following Sealing Options pages is shown.

      

3. To seal recordings, do the following: 

a. Select I want to seal recordings. 

b. Choose either one of the Destination options (available if archive options are set to Network) 

4. When all changes are complete, click OK. 
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Templates 
Templates include Quick Notes, which ensure consistency in the use of terminology in each log sheet.  A template 

is typically created for each case type and is stored in a shared network folder for all users to access, as required.  

See Administration above. 

Template Quick Notes 

Quick notes are commonly used words or phrases that are inserted in a log sheet with a simple keyboard 

shortcut.  Each template includes quick notes, which are copied to the log sheet that is based on the template. 

Note:  When quick notes are edited in a log sheet, they are not changed in the template.  The template ensures 

that a consistent set of quick notes is available when a new log sheet is created.  See Log Sheet Quick Notes in the 

Taking Notes section, later in this guide. 

Managing Templates 

You can create templates containing unique Quick Notes for each case type.  This is typically done at installation 

time. 

To manage templates: 

1. Click the Menu button , point to Tools and click Templates. 

2. Observe that the Templates dialog box is open. 

 

3. To create a new template, click New.  Enter a template name and click OK. 

 

4. To create a new template based on an existing template, select an existing template and click Copy As.  Enter 

a new name for the template and click OK. 

5. To rename a template, select it from the list of templates and click Rename.  Change the name as required 

and click OK. 

6. To delete a template, select it from the list and click Delete.  Click Yes in the confirmation dialog box. 

7. When finished you can modify the default quick notes for each template. 
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Managing Template Quick Notes 

Once templates are created, you can define the relevant default quick notes. 

To modify template quick notes: 

1. Click the Menu button , point to Tools and click Templates. 

2. From the Templates dialog box, select the template you want to modify and click Quick Notes.

 

3. Observe that the Quick Notes dialog box opens. 
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4. To add a new quick note do the following: 

a. From the Quick Notes dialog box, click New. 

b. In the New key field, enter the required keyboard shortcut. 

c. In the Label field enter the title for the quick note – e.g. Prosecutor. 

Note:  The label field is optional but will be automatically set to the quick note text if you leave it blank. 

d. In the Quick note field, enter the required word or phrase.  You can include control codes to manage the 

placement of text in the log sheet.  For more details, see Control Codes at the end of this section.

 

e. Click Save to add the quick note to the template. 

f. Repeat this process until all quick notes are added then click Close. 

5. To change an existing quick note: 

a. From the Quick Notes window, select the quick note you want to modify and click Edit. 

b. From the Edit Quick Note dialog box, make the required changes and click OK. 

6. When all quick note changes are complete, click Close to return to the Templates dialog box. 

7. From the Templates dialog box, click Close. 
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Control Codes 

Each quick note can include one or more control codes that control the placement of text in a log sheet.  

Available control codes are:  

<Left>  Moves the cursor to the last position in the Speaker column of the current log note. 

<Right>  Moves the cursor to the last position in the Note column of the current log note. 

<End>  Moves the cursor to the Speaker column of the last empty log note. 

New Line Inserts a new line in the current log note field. 

 

Note:   

Your column titles may be different.  Speaker and Note are default column titles that may 

have been changed. 

A New Line code is not shown.  Clicking the New Line control code button simply inserts a new 

line. 

 

You can combine control codes to extend their usefulness.  The table below lists some examples. 

Control Code & Text Result 

<END>Called & sworn<RIGHT> The text, Called & sworn, is immediately inserted in the 
last empty row of the Speaker column, a time stamp is 

automatically generated and the cursor is positioned in the 

adjacent Note column 

<END><RIGHT>Court adjourned A time stamp is automatically generated and the text, 

Court adjourned, is immediately inserted in the Note 

column of the last empty row. 

<LEFT>Exhibit 

Police Record of Interview 

 

 

From the current cursor position moves to the speaker 
field of the current log note and inserts Exhibit, then 

creates a new line and inserts Police Record of 

Interview. 
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Recording and Monitoring 
Using FTR Reporter you can start and stop recording and then monitor the venue using FTR Player.  You can also 

switch between sealed and public recording, if sealing has been configured in Options. 

Start, Pause, Stop, and Seal Recording 
You can start, pause, stop and switch between sealed and public recording from the Recorder bar or from the 

menu. 

To start, pause and switch recording: 

1. Do one of the following: 

a. From the Recorder Toolbar, click  to start recording or 

b. Click the Menu button , point to Record and click Start. 

2. Observe that the Start Recording button  changes to the Wait button  while Reporter is preparing 

to record 

Note:  Depending on the specifications of your recording computer and the configured audio and/or video 

devices, a small delay may occur in switching to the Pause button. This delay is indicated by the Wait button.  

3. If Save destination has been enabled, observe the Pause button  while recording is occurring. 

4. If Save destination has not been enabled, observe the Recording button  while recording is occurring. 

5. Observe that the record time display switches from dashes to an advancing time. 

From   to  

6. Observe that FTR Player automatically starts and plays the active recording – Confidence Monitoring. 

7. To switch between public and sealed recording, click .   

When recording is sealed, the record time display is shown with a red border . 

8. To pause recording, click  . 

9. Observe that the flashing Pause button  changes to the Resume recording  button. 

10. Observe that the record time display changes to dashes. 

11. From   to  

To stop recording: 

1. Click the  button to conclude the recording. 
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Monitoring 

The recording venue can be monitored using FTR Player. 

You can play at any time in the recording or you can play at the end.  If you play at the end you are Confidence 

Monitoring. 

Using FTR Player 

Use FTR Player to play existing recordings or to confidence monitor an active recording. 

The player can be used in Normal View or Compact View. 

Normal View 

The player normal view shows the full graphical representation of the loaded recording and provides the full 

range of features to manipulate the recording, as required. 

 

Compact View 

The compact player provides a basic set of features to play a recording.  It takes up very little desktop space 

and is always on top of other programs (when not docked to the FTR Reporter window).  If the compact 

player is dragged near the FTR Reporter window it will dock on the recorder bar, adjacent to the location 

name.  To drag the compact player, click anywhere that is not a display or control. 

Note:  When dragging the compact player be sure to click outside the rectangular area that 

encompasses the volume slider. 

When the compact player is not docked, you can position it anywhere on your screen.  As an example, 

transcript typists would typically place the compact player in the title bar of their word processor. 

 

For more details about how to use the player refer to FTR Player User's Guide or Help. 
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Video Window 

By default the video windows open when you open recordings that contain video.  If you choose to close the 

video windows you can re-open them at any time. 

 

To view video: 

1. If not already open, do one of the following from FTR Player: 

a. To open one window for all channels click  (Normal View) or  

b. To open multiple windows for all channels click  (Normal View) or 

c. Click  in Compact View or 

d. Press ALT+V 

2. To switch to and from full screen video double click the video window.   

3. To close the video window, do one of the following: 

a. From the video window click the close button or 

b. Press ALT+V 
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Confidence Monitoring 

Confidence monitoring is playing the latest available content while the recording is in progress.  To be confidence 
monitoring you must be playing at the end.  When you are playing at the end, the current play time is within four 

seconds of the current record time displayed on the Recorder Bar. 

To confidence monitor: 

1. Do one of the following:  

a. If not already recording, start recording.  Confidence Monitoring starts automatically. 

b. If you are already recording but playing an earlier time, click Play At End  from the Recorder Bar. 

2. If the current play time in the player is more than four seconds later than the current record time displayed on 

the Recorder Bar you can resume confidence monitoring by clicking Play At End . 

Tip:  When the player is in normal view an indicator is shown in the display whenever you are not playing-at-end.  

The display area also shows a Play-At-End button.  To resume playing-at-end you can click this button or the play-

at-end button on the Recorder Bar of FTR Reporter. 

 

 

  
Button:  Play-At-End  Indicator:  Playing away from the end 
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Taking Notes 
FTR Reporter includes a powerful note-taking feature that links each note to a precise place in the recording.  

Using this feature you can take brief notes as each event occurs and use them later when reviewing the 
recording.  As you enter each note, an automatic timestamp is added that links the note to the relevant place in 

the recording. 

Log Sheet Status Icons 
When you create a new log sheet, the log sheet tab includes status icons that indicate the relationship between 

the log sheet, the selected recorder and the content that is open in the player.  

Icon Description 

 only 
This log sheet is associated with the content currently open in the player but is not associated with the recorder.  Any new 
log notes are linked to the content in the player. 

 only 
This log sheet is associated with the selected recorder but is not associated with the content that is open in the player.  All 
new timestamps are taken from the recording time. 

and 

 

This log sheet is associated with the selected recorder and the content that is open in the player.  All new timestamps are 

taken from the current play time in the player. 

None The log sheet is not associated with the recorder or any content open in the player. 
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Creating Log Sheets 
When a new log sheet is created it is normally associated with the recorder.  A log sheet and recorder are 

associated when the date and location name in the log sheet matches the date and location name of the 

recorder.  

However, if the content in the player is not associated with the selected recorder, you are prompted to choose 

which content you want associated with the log sheet. 

There are two ways to create a new log sheet: 

• Create a new log sheet based on a template.  

• Create a new log sheet based on an existing log sheet. 

Create a Log Sheet Based on a Template 

As part of the installation process for FTR Reporter, templates are created that define standard quick notes for 

each case type.  You can choose one of these templates when you create a new log sheet. 

When you create a log sheet this way, the quick notes contained in the template, are copied to the log sheet. 

To create a new log sheet from a template: 

1. Do one of the following: 

a. To create a log sheet for the active recording, click Play At End  to ensure that the current recording 

is open in the player and that you are confidence monitoring. 

b. To create a log sheet for an existing recording, open the recording in the player.  See FTR Player help for 

more details. 

2. Do one of the following: 

a. Click Menu button , point to File and click New or 

b. Click New  from the toolbar. 

3. If more than one template is available, the Choose a Template dialog box is displayed.  Select the required 

template and click OK. 

4. Observe the following: 

a. If you created a new log sheet for the recorder (from step 1a) the location name matches the Recorder 

location name, which is displayed in the recorder bar. 

b. If you created a new log sheet while the recorder is not associated with the content that is open in the 

player (from step 1b), you are prompted to choose.  To associate the new log sheet with the recorder, 
click the Recorder option and click OK.  To associate the log sheet with the content in the player, click 

the Player option and click OK. The location and date of the log sheet matches your selection. 

Continue from an Existing Log Sheet 

Some matters can take several days or weeks to reach a conclusion.  To ensure that information is retained from 
one day to the next, you can create a new log sheet based on an existing log sheet.  The Description, quick notes 

and word list are copied from the old log sheet to the new log sheet. 

You can continue from: 

• A recent log sheet. 

• Using this method, you do not have to open an earlier log sheet to continue with a new log sheet. 

• The active log sheet. 

• This method requires that you open a log sheet first.  This is necessary if the required log sheet is no longer 
in your list of most recently used log sheets. 
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Continue From a Recent Log Sheet 

When continuing from a recent log sheet it is not necessary to open the log sheet.  

To continue from a recent log sheet: 

1. Click Most Recent . 

2. From the Most Recent dialog box, select the required log sheet and click Continue from. 

 

3. Observe the following: 

a. A new log sheet is created with the current date and recorder location name.  

b. The Description field contains all the information from the recent log sheet. 

4. Make any required changes to the information in the Description field. 

5. Make any required changes to the quick notes that were copied from the recent log sheet. 

Continue From an Old Log Sheet 

When continuing from an old log sheet it must first be opened. 

To continue from an old log sheet: 

1. Search for and open the required log sheet.  See File Search later in this guide. 

2. Click the Menu button , point to File and click Continue from. 

3. Observe the following: 

a. A new log sheet is created with the current date and recorder location name.  

b. The Description field contains all the information from the recent log sheet. 

4. Make any required changes to the information in the Description field. 

5. Make any required changes to the quick notes that were copied from the recent log sheet. 

6. If necessary, close the older log sheet from which you continued the new log sheet. 
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Entering Heading Information 
The log sheet heading consists of the Description, Date and Location fields. 

 

Description Field 

Use the Description field to describe the contents of the log sheet. 

Whenever a new log sheet is started the cursor is automatically positioned in the empty Speaker field.  While it 

is recommended that you enter a description before a case commences it is not mandatory.  You can enter a 

description at any time. 

To enter text in the Description field 

1. Click the Description field or press CTRL+HOME. 

2. Enter the required text.  As you type, the text wraps to the next line as required. 

Tip:  If you wish to force a new line, press SHIFT + ENTER. 

3. When you have completed the entry for the Description field press ENTER. 

Note:  When you press ENTER, the cursor jumps to the last row of the log sheet.  The last row 

is always an empty note. 

The Location Field 

The Location field is automatically completed when you create the log sheet.  It will be the location name of the 

recorder (seen in the Recorder Bar) or the location name of the content that is open in the player. 

Date Field 

The Date field is automatically completed when the log sheet is created and cannot be changed.  The date 

appearing in this field is one of the following: 

• Computer system date if:  

The player is not started. 

The player is started but not loaded with any content. 
The player is started and you are listening to the current recording. 

• Date of recording if:  
The content that is open in the player does not match the recorder and you opted to associate the log sheet 
with the player. 

http://www.fortherecord.com/


 
 

 

 
 
 

Page 60 
© FTR Pty Ltd, 2021. All Rights Reserved. 

For more information visit www.fortherecord.com 

 

FTR Reporter 

Entering Log Notes 
When you create a new log sheet, it is in edit mode.  When you open an existing log sheet, it is in read-only 

mode.  The edit/read-only mode is indicated in the log sheet tab ( ).  The active log sheet must be in edit mode 

and be associated with the recorder or the content that is open in the player. 

Note:  If the player and recorder are both associated with the log sheet, timestamps are taken from the play time 
in the player. 

If you are taking "live" notes, be sure to play the latest available content by clicking the Play At End button  

from the Recorder Bar. 

To add a log note: 

1. Do one of the following: 

a. If you want to take notes for the recorder, start recording.  This action causes the player to open the 

active recording and set the play time to play-at-end. 

b. If you want to take notes for an existing recording, open the recording in the player. 

2. Create a new log sheet or open an existing log sheet that is associated.  See Creating a Log Sheet earlier in 

this guide or Opening a Log Sheet later in this guide. 

3. If the log sheet is read-only ( ), click the Edit/Read-only button  from the toolbar. 

4. Do one of the following: 

a. Press ENTER from anywhere in the log sheet to move to the last blank log note row or click to select one 
of the last empty fields and start typing when you hear an event that requires a note.  This action 

automatically inserts a time-stamp. 

Note:  The first key press could also be a quick note.  See Quick Notes later in this guide. 

b. Press CTR+ENTER to add an instant timestamp at the end of the log sheet, without entering text.  You 
can go back and add the text when convenient.  Use this method when events are happening faster than 

you can enter notes. 

5. If you want to add notes for earlier times in the recording see Back Annotating later in this guide. 

Note:  To undo any typing in a cell click the Undo button from the toolbar. 

Deleting a Note 
It sometimes occurs that a log note is created in error or becomes redundant.  You can delete a single log note 

whenever the log sheet is in edit mode.  Multiple notes cannot be deleted in a single operation.  

To delete a log note: 

1. Do one of the following: 

a. Right-click in any column of the log note to be deleted and click Delete Log Note or 

b. Position the cursor in the note to be deleted, click the Menu button , point to Edit and click Delete 

Log Note. 

2. A dialog box prompts you to confirm the deletion.  Click Yes to proceed.  
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Tagging Hearings 
In some work environments it is necessary to produce a single recording file for each hearing created during the 

day.  The single recording file is created using a task in FTR Manager - Export panel.  The Convert Tagged 
Recordings task searches each log sheet for tags that identify the start and end of each hearing and creates the 

recording files.  The tags are inserted as notes using the Tag Hearing Start and Tag Hearing Stop commands.  

The Tag Hearing Start command prompts the user for a suitable name to identify the hearing - typically a case 

reference number or name.  This information is used to name the mp3 recording file that is created. For this 

reason it is important to not edit the note, once it is inserted in the log sheet. 

A typical hearing start tag looks like this: 

<Hearing Start> <123 of 2011> MP3 file name.  DO NOT EDIT THIS NOTE 

To insert a hearing tag: 

1. Create a new log sheet and start recording. 

2. When the hearing starts, do one of the following: 

a. Click the Menu button  , point to Tools and click Tag Hearing Start or  

b. Press Alt+H. 

3. In the Tag: Hearing Start dialog box, enter the hearing name. 

4. Observe that a Hearing Start tag is inserted in the log sheet. 

5. Continue with playback and when the hearing ends, do one of the following: 

a. Click the Menu button , point to Tools and click Tag Hearing Stop 

b. or press Ctrl+Alt+H 

Note:  Always insert a Tag Hearing Stop note when each hearing concludes, EVEN IF IT IS 

THE LAST HEARING OF THE DAY.  The Tag Hearing Stop note is used by FTR Manager to find 

the end of each hearing. 

6. Continue with this process until all hearings are tagged. 

Note: ALT+H and Ctrl+Alt+H are the default keyboard shortcuts.  These can be changed in the VBA code if 

required.  Please consult the Administrators guide for details. 

Back Annotating 
While taking notes with an active recording it may be necessary to add more notes for earlier sections of the 

recording.  To do this the current play time must be set to the point in the recording that requires a note.  

There are two ways to adjust the current play time: 

• Use the Level History 
The level history bar in FTR Reporter provides a graphical representation of audio activity from each 

recording channel.  It is very easy to see a channel become active.  The period displayed by the Level History 

bar is set in FTR Reporter Options and the current play time control can be moved within the set time.  If you 
want to select a time outside the level history period you need to use the player. 

• Use the player 
The player opens the whole recording from the recorder so you can select any time from the commencement 

of recording to the current time.  See FTR Player help or user’s guide for details on selecting a current play 
time. 

To back annotate using the level history bar: 

1. If level history is not available, click the Menu button , point to View and click Level History. 

2. Using the Level History bar as a guide, click the location on the bar that requires an additional note.  You can 

also drag the play time control tab to the required position. 
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3. Observe that the current playtime in the player also jumps to the selected time. 

Note:  If the player is loaded with a recording that is not associated with the recorder, the 

correct recording is automatically opened in the player and the play time set accordingly. 

4. Press ENTER to ensure that you are at the end of the log sheet. 

5. Start typing the note. 

6. Observe that the note is inserted at the current play time displayed in the player. 

7. Continue this process until all back-annotations are entered. 

Note:  To return to live note taking, be sure to click Play At End  to play the latest 

available content form the selected recorder. 

To back annotate using the player: 

1. Use the player to locate the time requiring a note.  See FTR Player help or user’s guide for help on adjusting 

the current play time. 

2. Press ENTER to ensure that you are at the end of the log sheet. 

3. Start typing the note. 

4. Observe that the note is inserted at the current play time displayed in the player. 

5. Continue this process until all back-annotations are entered. 

Note:  To return to live note taking, be sure to click Play At End  to play the latest 

available content form the selected recorder. 

Selecting Text 
While working with log sheets you can select portions of text in a field to:  

• Apply formatting 

• Add to Quick Notes 

• Delete 

• Copy to the clipboard 

Note:  Text selection within a log note field is not available if the log sheet is in read-only mode.  However you 

can copy the entire contents of any field in a read-only log sheet. 

You can also select a number of notes (rows) to: 

• Save as a new log sheet 

• Print 

• Apply formatting (maximum of 10 rows at a time) 

Mouse Selection 

The following steps describe how to select text or rows using the mouse. 

To select text within a log note field: 

1. Position the cursor in the first word of the required text. 

2. Do one of the following: 

a. Double click to select the current word or 

b. Drag the cursor over the required text. 

3. Carry out the required action on the selected text. 

To select one or more notes (rows): 
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1. Position the pointer over the row selector for the first required log note. 

2. Row Selector →  

3. When the pointer changes to a right arrow, click to select the current row. 

4. To add more rows to the selection do one of the following: 

a. Press SHIFT and click the row selector of the last required log note, in a range of adjacent notes, to select 

all notes between or 

b. Press CTRL and click the row selector of each log note you wish to add to the selection. 

5. Carry out the required action on the selected text. 

Keyboard Selection 

The following steps describe how to select text or rows using the keyboard.  

To select text within a log note field: 

1. Position the cursor where you want the selection to start. 

2. Do one of the following: 

a. Press SHIFT+RIGHT to select the character to the right and repeat until the required text is selected or 

b. Press SHIFT+LEFT to select the character to the left and repeat until the required text is selected or 

c. Press SHIFT+END to select to the end of the line or 

d. Press SHIFT+HOME to select to the beginning of the line or  

e. Press SHIFT+DOWN to select to the end of the current line plus the all text in the next line - up to the 

same relative cursor position or 

f. Press SHIFT+UP to select to the beginning of the current line plus the all text in the previous line - back to 

the same relative cursor position 

Tip:  To cancel the current selection, press any cursor key.  To replace the current selection, start typing. 

3. Carry out the required action on the selected text. 

To select one or more notes (rows): 

1. Position the cursor in the first row of the required selection. 

2. Do one of the following: 

a. Press CTRL+SPACEBAR to select the current row and then press UP or DOWN until the cursor is in the last 

row of the required adjacent block of rows.  Press CTRL+SHIFT+SPACEBAR to select all rows between or 

b. Press CTRL+SPACEBAR to select the current row and then press UP or DOWN until the cursor is in the 
next required row.  Press CTRL+SPACEBAR to add the row to your selection.  Repeat this for all required 

rows or 

c. Use both previous methods to select a combination of adjacent and non-adjacent rows. 

Tip:  Pressing ESC (or any keyboard combination other than those described above) cancels the whole 

selection.  The cursor remains in its current position when the selection is cancelled. 

3. Carry out the required action on the selected text. 
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Formatting Text 
While creating notes, it is often helpful to highlight selected text in some way.  You can do this by applying 

formatting to the required text or row. 

Available formatting options are: 

• Style - Bold, Italics and Underline or any combination 

• Color 

You can apply formatting to selected text or you can simply change the format at the current cursor position and 

any new text that is entered there adopts the newly selected format. 

When opening the Select Format dialog box with text selected, the options indicate the current formatting of 

the selection.  If part of the selection is formatted differently to other parts of the selection, the relevant 
formatting option is shaded.  Clicking a shaded option clears that format from the entire selection.  Leaving the 

shaded option has no effect on that format option and the selection remains unchanged. 

Note:  If you have multiple rows selected, the format dialog box shows all options cleared. 

To format log note text: 

1. Do one of the following: 

a. If you wish to apply formatting to existing text or notes, make the required selection.  

b. If you wish to apply formatting to text yet to be entered, position the cursor where the new text is to 

start. 

2. Click the Menu button , point to Edit and click Format. 

3. From the Select Format dialog box, select a Style and Color. 

 

4. When the required format selections are made, click OK. 
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Log Sheet Quick Notes 
Quick notes are commonly used words or phrases that are inserted in a log sheet with a simple keyboard 

shortcut.  When a log sheet is created, quick notes are copied from the template and stored in the log sheet.  
These copied quick notes become the log sheet quick notes.  Any changes made to log sheet quick notes are 

stored in the log sheet and have no effect on template quick notes. 

Note:  When quick notes are edited in a log sheet, they are not changed in the template.  The template simply 

ensures that a consistent set of quick notes is available when a new log sheet is created.  Template quick notes 

can be edited – see Managing Template Quick Notes earlier in this guide. 

Viewing Quick Notes 

You can view the full list of quick notes contained in your log sheet by opening the quick notes window.  While 

the quick notes window is not required to insert quick notes in a log sheet, it is required if you want to make 

changes to your quick notes. 

To view the quick notes contained in your log sheet: 

1. Do one of the following: 

a. Click the Quick Notes button  or 

b. Click the Menu button , point to Tools and click Quick Notes. 

2. Observe that the Quick Notes window is displayed.  Position and size the window to suit your desktop layout. 

 

3. To view the full quick note, point to the required note and a screen tip is displayed. 

Note:  The Copy button is used for printing quick notes.  See Printing Quick Notes later in this 

guide for more details. 
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Creating a New Quick Note in the Log Sheet 

There are two ways to create a new quick note. 

• Open the Quick Notes window and click the New button or 

• Select text in your log sheet and use a keyboard shortcut to add it to the list of quick notes. 

Creating Quick Note from the Quick Notes Window 

Use this method if you want to view your current quick notes while you make changes. 

To add a new quick note: 

1. Open the Quick Notes window.  See the previous section. 

2. From the Quick Notes window, click New. 

3. Observe that the New Quick Note dialog box opens. 

 

4. Do the following: 

a. In the New key field, enter the required keyboard shortcut. 

b. In the Label field enter the title for the quick note – e.g. Prosecutor. 

Note:  The label field is optional but will be automatically set to the quick note text if 

you leave it blank 

c. In the Quick note field, enter the required word or phrase.  You can include control codes to manage 

the placement of text in the log sheet.  For more details, see Control Codes at the end of this section. 

5. Click Save to add the quick note to the template. 

6. Repeat this process until all new quick notes are added, then click Close. 
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Creating a Quick Note from a Selection 

Use this method to create a Quick Note from a selection of text in your log sheet. 

Note:  The Quick Notes window does not need to be open when adding new notes with this 

method. 

To make a quick note from a selection: 

1. From your log sheet, select the word or phrase you want to add as a new quick note. 

2. Press Shift+F3. 

3. Observe that the New Quick Note dialog box opens with the selected text shown in the Quick Note box. 

 

4. Enter a keyboard shortcut in the New Key box and an optional Label. 

5. Enter any relevant control codes. 

6. Click OK. 
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Editing and Deleting Quick Notes 

You can edit existing quick notes from the Quick Notes window.  See Viewing Quick Notes earlier in this section.  

To edit existing quick notes: 

1. From the Quick Notes window, select the quick note you want to change and click Edit. 

2. Observe that the Edit Quick Note dialog box opens and that the quick note details are available for editing. 

 

3. Make the necessary changes and click OK. 

4. Repeat this process until all changes are completed. 

To delete a quick note: 

1. From the Quick Notes window, select the quick note you want to delete. 

2. Click Delete.  

3. Click Yes from the confirmation dialog box to proceed with the deletion. 
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Inserting Quick Notes in a Log Sheet 

You can insert a quick note in your log sheet using keyboard shortcuts or from the Quick Notes window.  

Tip:  When inserting a quick note using keyboard shortcuts, the quick notes window does not need to be open. 

To insert a quick note: 

1. If you want to insert a quick note using the assigned keyboard shortcut, do the following: 

a. Position your cursor where you want the quick note inserted in your log sheet. 

b. Press the assigned keyboard shortcut for the quick note. 

Tip:  If you are unsure of the assigned keyboard shortcuts you can open the Quick Notes 

window and leave it open while you work.  See Viewing Quick Notes earlier in this guide. 

2. If you want to select a quick note from a list: 

a. Open the Quick Notes window.  See Viewing Quick Notes earlier in this guide.

 

b. Position your cursor where you want the quick note inserted in your log sheet. 

c. Do one of the following: 

i. Double-click the required item from the list. 

ii. Click the required item from the list and press Enter. 

iii. In the Type the item... box, start typing the label.  As a label matches what you type it is 

highlighted in the list.  When the required item is highlighted, stop typing and press Enter. 

3. Observe that the quick note is inserted in your log sheet. 
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Word List 
The Word List stores information that can be viewed in a separate window from the log notes.  Typical uses for a 

word list are: 

• Spelling list - keeps a record of difficult words or names.  The list becomes a reference for transcription staff. 

• Witness list – keeps a log of witnesses as they appear. 

Viewing the Word List 

• You can view the Word List while you work.  

To view the Word List: 

1. Click the Menu button , point to Tools and click Word List. 

2. Observe that the Word List is now displayed in a separate window.

 

3. Size and position the Word List window to suit your desktop. 
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Inserting Word List Items in a Log Sheet 

You can insert a Word List item in your log sheet from the open list window.  

To insert a Word List item: 

1. Click the Menu button , point to Tools and click Word List. 

2. Observe that the Word List window is open. 

 

3. Position your cursor where you want the list item inserted in your log sheet. 

4. Do one of the following: 

a. Double-click the required item from the list. 

b. Click the required item from the list and press Enter. 

c. In the Type the item box, start typing the item.  As a list item matches what you type, it is highlighted in 

the list.  When the required item is highlighted, stop typing and press Enter. 

5. Observe that the list item is inserted in your log sheet. 
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Creating a New Word List Item 

There are two ways to add items to the Word List.  

• From the Word List window, click New or 

• Select text in your log sheet and use a keyboard shortcut to add it to the list. 

Creating a Word List Item from the Word List Window 

Use this method if you want to view the list while you make changes. 

To add an item to the list: 

1. Open the Word List window.  See the previous section. 

2. From the Word List window, click New. 

3. From the New Item dialog box, enter the text you wish to add and click Save.

 

4. Observe that the new item is now displayed in your list. 

Creating a List item from a Selection 

Use this method to create a list item from on a selection of text in your log sheet.  

Note:  The Word List window does not need to be open when adding new items to the list. 

To add a list item from a selection: 

1. From your log sheet, select the word or phrase you want to add as a new list item. 

2. Press Shift+F4. 

3. When the item is added, a confirmation dialog box is displayed.  Click OK. 

Editing Word List Items 

You can edit existing items in the Word List.  

To edit the Word List: 

1. From the Word List window, select the item you want to change and click Edit. 

2. Observe that the Edit Item dialog box opens and that the item details are available for editing. 

3. Make the necessary changes and click OK. 

4. Repeat this process until all changes are completed. 

Deleting Word List Items 

You can delete existing items from the Word List.  

To delete a Word List item:  

1. From the Word List window, select the item you want to delete. 

2. Click Delete. 

3. Click Yes from the confirmation dialog box to proceed with the deletion. 
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Spell Checking 
FTR Reporter includes a spell checker, which can check the spelling of a selection or the whole log sheet.  

To spell check: 

1. To check a selection of text, make your selection first.  See Selecting Text earlier in this guide.  With nothing 

selected, the whole log sheet is checked. 

2. Do one of the following: 

a. Click the Menu button , point to Tools and click Spelling or 

b. Click the Spell Check button . 

3. Observe that if a spelling mistake is found in any field of the log sheet, the Check Spelling dialog box is 

displayed. 

 

The log sheet field that contains the error is displayed in the dialog box and the error is highlighted in the 

Not in Dictionary box. 

4. From the Check Spelling dialog, take the necessary steps as required. 

5. When spell checking is finished, a confirmation message is displayed.  Click Yes. 

Note:   

You can change the language setting for the spell checker when the Check Spelling dialog box 

is displayed – click Options. 

Alternatively you can set the language in General Options.  See Changing General Options 

earlier in this guide. 
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Save copy as and Copying Log Sheets 
FTR Reporter automatically saves the active editable log sheet at regular time intervals.  Automatic saves also 

occur every time you change the information in one field and move to another field.  If a problem arises with 
automatic saving, the process for recovery depends on where the log sheet is being saved.  See Recovering From 
a Save Failure later in this section. 

You can also save a copy of the current log sheet, or a selection of notes from the active log sheet, to another 

location.  After saving a copy, the original log sheet remains active.  To view the copy, follow the normal 

procedure for opening a log sheet. 

When saving a copy you can choose one of two formats. 

• FTR Log Sheet (*.fls) 

• Web Page (.htm) - for users that do not have access to FTR Log Notes. 

When saving a selection of notes, the Log Sheet Heading is also saved. 

To save a copy of a log sheet: 

1. If required, select the relevant notes. 

2. Click the Menu button , point to File and click Save Copy As  from the toolbar. 

3. Observe that the Save Copy As dialog box is displayed. 

 

4. From the Save Copy As dialog box do the following: 

a. Choose a drive and folder in which to copy the log sheet. 

b. Choose the format from the Save as type list. 

c. Enter the required name in the File name box or accept the default. 

5. When you are satisfied that your file name and type are correct, click Save to save a copy of the log sheet. 
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Recovering From a Save Failure 
The default save location for your log sheets could be to a shared network folder or to a local folder on your 

computer.  The procedure for recovery is dependent on where the save folder is located. 

Network Save Failure 

If the save location is set to a network folder, log sheets are automatically saved to a temporary folder on your 

computer.  At regular intervals the temporary log sheet is copied to the specified save location. 

If the shared folder becomes unavailable, the log sheet continues to be saved to the temporary folder on your 
computer and you can continue to work uninterrupted.  If the shared folder becomes available, before you exit 

the program, the temporary log sheet is copied to the save location – overwriting the obsolete version.  All of this 

activity occurs in the background without interruption to your normal procedures. 

If the shared network folder is not available when you close the program, a message box is displayed with the 

following information: 

• One or more log sheets have not been saved to the specified save location 

• The temporary files will remain 

• The next time FTR Reporter is started the temporary log sheets will be saved to the specified save location. 

 

On closing the message box the temporary files are left intact.  The next time FTR Reporter is started the 

temporary files are immediately saved to the specified save location. 

Note:  You may be prompted with additional messages if the temporary files are older than log sheets of the 

same name in the save location.  Follow the prompts as required. 

Local Save Failure 

If your specified save location is local to your computer (such as a hard disk drive) and FTR Reporter is unable to 
save, a message is displayed prompting you to save a copy of the log sheet to another location.  Once you have 

saved a copy, close the active log sheet, open the saved copy and continue. 

REMEMBER TO SAVE THE COPY BACK TO THE ORIGINAL SAVE LOCATION WHEN THE PROBLEM IS RESOLVED. 

Closing Log Sheets 
You can close the active log sheet or any other log sheet. 

To close the active log sheet: 

1. Do one of the following: 

a. Click the Menu button , point to File and click Close or 

b. Right-click the tab and click Close from the shortcut menu or  

c. Click the Close button  to the right of the log sheet tabs. 

2. Observe that the previously accessed log sheet becomes the active log sheet. 

To close an inactive log sheet: 

1. Right-click the tab and click Close from the shortcut menu  

2. Observe that the currently active log sheet remains active. 
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Reviewing Log Sheets 
Using FTR Reporter, you can review a recording and any associated log sheets.  You can back-annotate a current 

recording or simply review any previous recording. 

 

With FTR Reporter you can: 

• Open an existing log sheet 

• Associate a log sheet 

• Find specific text in a log sheet 

• Set a range 

• Synchronize notes 

Opening Log Sheets 
There are three ways to open a log sheet. 

• Open most recent 

• Open 

• Search 
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Open Most Recent 

You can open a log sheet from your list of most recently used log sheets. 

To open a recently used log sheet: 

1. Do one of the following: 

a. Click the Most Recent button , select the required log sheet in the Most Recent dialog box and 

click Open, or 

 

b. Click the Menu button , point to File and click the required log sheet from the File menu. 
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Open 

Using Open requires an understanding of where log sheets are stored.  If you don't know where to find your log 

sheets it is simpler to use Search.  See the next section for more details.  

To open a log sheet: 

1. Click the Menu button , point to File and click Open. 

2. From the Open dialog box, navigate to the required drive, folder and log sheet. 

 

3. Click Open. 
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Search 

Searching provides a more efficient way of finding and opening log sheets.  You can specify a number of different 

criteria to search for the required log sheet. 

From the Results list, you can copy, delete or print log sheets without the need to open them.  Finally, one or 

more (maximum of 10) log sheets can be opened for review. 

The diagram below illustrates the Search dialog box.  The table following this diagram describes each element. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Element Description 

Description Use the Description box to enter text you know can be found in the Description field of the required log sheets. 
This is the most frequently used search parameter. 

Location If you know where the case was heard, use this box to enter a Location name.  

Log Notes Use this box to enter text you know can be found in the Speaker or Note fields of the required log sheets. 

Search period Always use a search period to limit the scope of the search. 

Search Click this button to search with the defined criteria. 

Reset When you click this button, all text boxes are cleared and the search period is set to one month from the current day. 

Look in This is a list of search folders which are setup at installation time by your administrator or support staff 

Results When a search concludes all log sheets that match the search criteria appear in this list.  To view more information about 
each log sheet point to the Description to open a screen tip that shows the full description. 

Open Opens one or more log sheets from the results list. 

Save Copy As Saves a copy of one or more logs sheets to another location. 

Print Click this button to print one or more log sheets from the results list. 

Delete Deletes one or more log sheets.  Deleted log sheets are moved to the recycle bin and can be restored. 

Close Closes the Search dialog box.  You can keep the dialog box open while you work with FTR Reporter. 

  

 

Search Now 

Delete Print Save Copy As 

Open 

Search 

Results 

Look in  

search folder 

Search text 

Reset search criteria 

Manage Search Folders 

Close 

Search period 
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To search for log sheets: 

1. Do one of the following:  

a. Click the Search button  or 

b. Click the Menu button , point to File and click Search 

2. In the Search dialog box, enter search criteria as previously described. 

3. Do one of the following: 

a. Accept the folder currently displayed in the Look in box or 

b. Change the Look in folder by selecting it from the pull down list of configured search folders.  

4. Click Search.  Log sheets that match your search criteria are displayed in the search results list. 

Note:  You can change the sort order of the Search Results list by clicking on the Date, 

Location or Description headings. 

5. Select one or more log sheets and click Open. 
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Save Copy As, Print or Delete Multiple Log Sheets 

Once you have completed a search, all log sheets matching the search criteria appear in the Search Results list.  

You can open, save a copy, print or delete one or more of the listed log sheets.  

To select a single log sheet, simply click the log sheet in the Search Results list.  To select multiple log sheets, 

hold the SHIFT key down while clicking the first and last log sheets in a series of adjacent log sheets.  To select 

multiple log sheets that are not adjacent, hold the CTRL key down while clicking each required log sheet.  

Note:  You can delete or save copy of, up to 100 log sheets.  You can open or print a maximum of ten log sheets. 

To open log sheets: 

1. Perform a search for the required log sheets - as previously described. 

2. Select one or more log sheets, to a maximum of 10, from the Search Results list. 

3. Click Open.  

Note:  Log sheets open in read-only mode. 

To copy log sheets: 

1. Perform a search for the required log sheets - as previously described. 

2. Select one or more log sheets (to a maximum of 100) from the Search Results list. 

3. From the Search dialog box click Save Copy As. 

4. From the Save Copy As dialog box choose a file name and file type.  

Note:  You can only change the name if a single log sheet is selected.

  

5. Click Save. 
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To print log sheets from the Search window: 

1. Perform a search for the required log sheets - as previously described. 

2. Select one or more log sheets (maximum of 10) from Search Results and click Print. 

3. From the Print dialog box do one or both of the following: 

a. Select the Heading Pages check box to print the contents of the Description, Date and Location 

fields. 

b. Select the Log notes option to print all notes. 

Note:  The Selection option is not available when printing from the Search dialog box.  See Printing 

later in this guide for details on printing a selection from the active log sheet. 

  

4. Click OK. 

5. The selected log sheets are printed using the default printer and page setup.  For details on changing the 

default page setup see Printing later in this guide. 

To delete log sheets: 

1. Perform a search for the required log sheets - as previously described. 

2. Select one or more log sheets from the Search Results list. 

3. Click Delete. 

4. A dialog box prompts you to confirm the deletion.  Click Yes to proceed.  All selected log sheets are deleted 

from the current directory but are available for restoration from the system Recycle Bin. 
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Associating a Log Sheet 
When you open an existing log sheet, it may not be associated with the recorder or the content that is open in 

the player.  To enter log notes in such a log sheet it must be associated with content that is open in the player. 

Associating a log sheet with a recording makes the timestamps available for locating specific events in the audio.  

It also adds the Range Bar to the log sheet, which indicates any Range Start times, Range End times and the 

most recent log note relevant to the current playtime. 

An associated log sheet provides updates on the relationship between the notes and the Current Play Time in 

the player.  As the Current Play Time advances the Current Log Note Marker automatically jumps to the 
next relevant log note as the log note time is reached.  If the log note is hidden when this occurs the log sheet is 

automatically scrolled to make it visible. 

To associate a log sheet: 

1. Open the required log sheet.  See Opening Log Sheets earlier in this guide. 

2. Do one of the following: 

a. Click a time stamp or 

b. Position the cursor in a log note, click the Menu button , point to Actions and click Link. 

3. Observe the following: 

If not already started, the Player starts and then scans search folders for any recordings that include the date 

and location of the log sheet.  If recording content is found with matching location name and date, it is loaded 

and the current play time set to the log sheet timestamp.  

Note:  Search folders are scanned in the order they are defined in the Player properties.  The 

first matching recording is opened.  See FTR Player User Guide for details. 

4. If matching audio is not found a message is displayed. 

Take the necessary steps to find and open the required audio.  See the FTR Player User Guide or help.  If the 

log sheet contains a Location Name that does match any recording in any folder, it may be incorrect.  Check 

that the Location Name is correct.  If you know that a recording does exist, use the player to find and open it.  

Then, from the log sheet, click the Location field and select the entry that matches the date and location of the 

recording.  Respond accordingly to any message box that is displayed. 

5. The associated audio opens in the player.  The Range Bar is displayed to the left of the log sheet and the 

current play time is set to the same time as the selected log note. 
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Setting the Audio Range 
If you are only interested in a certain group of events in the log sheet, you can limit the range of content 

available for review by setting a Range Start and Range End from the log sheet.  

A range can only be set from the log sheet if it is associated with the content that is open in the player.  

Alternatively, you can set a range directly in the player – see the FTR Player User's Guide or help for details. 

To set an audio range from the log sheet: 

1. Locate the log note that marks the beginning of the required range. 

2. Right-click the log note and click Set Range Start from the shortcut menu. 

3. Locate the log note that marks the end of the required range. 

4. Right-click the log note and click Set Range End from the shortcut menu.  

Note:  When a Range Start or Range End time is set a visual indication is provided in the 

Range Bar to the left of the log sheet.  See Range Bar earlier in this guide. 

Synchronizing Notes 
If a log sheet is created on a different computer from the one that created the audio recording it is possible that 
a discrepancy exists between the log note time stamps and the associated audio times for the related events.  If 

this situation exists, you can easily synchronize all timestamps in the log sheet, to the correct audio times, in a 

single step.  

It is also possible that a single log note is added too late to match the event in the audio.  Such an incorrectly 

time stamped log note can be synchronized to the actual event in the recording.  

Synchronizing a Log Sheet 

Synchronize Sheet is available from the Edit menu when a log sheet is in edit mode and the content loaded in 

the player, matches the location name and date of the log sheet. 

To synchronize all notes in a log sheet: 

1. Open the log sheet and switch it to edit mode. 

2. Associate the log sheet as previously described. 

3. Play until you reach a distinct event that is described by a specific log note and then stop. 

4. Click the Menu button , point to Edit and click Synchronize Sheet. 

5. A dialog box prompts you to confirm the synchronization.  Click Yes to proceed. 

6. Observe that all log note time stamps are adjusted by the same amount. 
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Synchronizing a Log Note 

Synchronize Note is available from the shortcut menu or the Edit menu when a log sheet is in edit mode and 

the content loaded in the player, matches the location name and date of the log sheet.  

To synchronize an individual log note with a recording: 

1. Open the log sheet and switch it to edit mode. 

2. Associate the log sheet as previously described. 

3. Play until you reach the distinct event for which the log note time stamp requires adjustment. 

4. Position the cursor in the log note you wish to adjust. 

5. Do one of the following: 

a. Click the Menu button , point to Edit and click Synchronize Note or  

b. Right-click the log note and click Synchronize Note from the shortcut menu. 

6. The time stamp for the selected log note is adjusted. 

Filtering Notes 
The Filter tool provides a way of extracting specific log notes from a log sheet.  For example, if you wish to make 

up a witness list you could filter the log sheet based on the phrase Witness called.  When the filter is activated a 
new log sheet opens consisting of all the notes that contain the selected phrase.  The heading information is the 

same as the original log sheet. 

When the temporary filtered log sheet is created it is locked to editing and is not saved.  If you close the filtered 

log sheet it is permanently deleted.  If you want to save or edit the filtered log sheet, save a copy, close the 

original (which is deleted on closing) and then open the copy.  The copy can be switched to edit mode. 

To filter notes: 

1. Do one of the following: 

a. Select the word or phrase to use as the filter text or 

b. Position the cursor in the required field - this action automatically uses the entire field contents as the 

filter text. 

2. Click the Menu button , point to Tools and click Filter. 

3. A message box reminds you to save a copy if you want to keep the log sheet.  Click OK to continue. 

4. The log sheet is scanned and any notes (rows) that contain the required filter text (in the same column as the 

required filtered text) are extracted and placed in a new active log sheet, which is locked to editing. 

5. If you wish to keep the log sheet, click the Menu button , point to File and click Save Copy As or click 

the Save Copy As  button from the toolbar. 
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Merging Log Sheets 
With FTR Reporter, you can merge multiple log sheets to create a new log sheet.  The heading and column titles 

of the active log sheet are used to create the heading and column titles of the newly merged log sheet.  The 

Description field is modified with a new first line containing the word Merged. 

When the temporary merged log sheet is created it is locked to editing and is not saved.  If you close the merged 
log sheet it is permanently deleted.  If you want to save or edit the merged log sheet, save a copy, close the 

original (which is deleted on closing) and then open the copy.  The copy can be switched to edit mode. 

To merge log sheets 

1. Open the log sheets to be merged. 

2. Select the log sheet containing heading information that you want copied to the heading of the merged log 

sheet. 

3. Click the Menu button , point to Tools and click Merge. 

Note: If one or more log sheets have different dates, a warning is generated.  You can still 

proceed with the merge but be cautious with log sheets of differing dates. 

4. From the Merge dialog box click Yes to merge the open log sheets.  The merged log sheet is displayed as the 

active log sheet and is locked to editing. 

5. Observe that the merged log sheet is the active log sheet and it is locked to editing. 

6. If you wish to keep the log sheet, click the Menu button , point to File and click Save Copy As or click 

the Save Copy As button  from the toolbar. 

Finding Text 
While reviewing a log sheet, it may be necessary to quickly locate notes pertaining to a particular event, speaker 

or comment. Use Find as a fast and effective method for searching the active log sheet for any occurrences of a 

specific word or phrase in the current log sheet.  

To find a word in a log sheet: 

1. Do one of the following: 

a. Click the Menu button , point to Edit and click Find or  

b. Click the Find button . 

2. In the Find Text dialog box, enter the text you wish to find. 

 

3. Click Find.  The Find Text dialog box is closed and the first occurrence of the required text is highlighted in 

the log sheet. 

4. To locate the next occurrence of the required text press ALT+F3. 
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Editing Log Sheets 
You can edit the contents of an existing log sheet at a later date.  When opening an existing log sheet it is 

displayed in read-only mode.  To make changes to the log sheet, change to edit mode.  

To switch between read-only and edit modes: 

• Click the Edit/Read-only button  or click the Menu button , point to Edit and click Edit Mode. 

Editing Existing Information 

You can edit the contents of an existing log sheet at a later date.  When opening an existing log sheet it is 

displayed in read-only mode.  To make changes to the log sheet, change to edit mode.  

To edit the log sheet: 

1. If not in edit mode, click the Edit/Read-only button  or click the Menu button , point to Edit and 

click Edit Mode. 

2. Enter or modify the Description field, as required. 

3. Select the log note field you wish to edit. 

4. Make changes as required. 

Adding a Log Note 

New notes can only be added to an existing log sheet when the log sheet is associated with the content that is 

currently open in the player. 

To add a log note to a log sheet: 

1. In the player, set the current play time to the time that requires a note. 

2. Press ENTER to position the cursor in the last row.  The last row is an empty log note. 

3. Enter the required log note.  At the first key press the log note is time stamped instantly and moved to the 

correct chronological position in the time sheet. 

Deleting a Log Note 

You can delete a log note if the log sheet is in edit mode.  Multiple notes cannot be deleted.  

To delete a log note: 

1. Right-click in any column of the log note to be deleted. 

2. From the shortcut menu click Delete Log Note. 

3. A dialog box prompts you to confirm the deletion.  Click Yes to proceed. 
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Archiving 
FTR Reporter supports archiving, which ensures that a copy of the recording and log sheets is maintained in 
another location.  For details on how to configure archiving options see Changing Archive and Backup Options 
earlier in this guide. 

If FTR Reporter is configured for Network archiving there is no action required by the user.  Archiving is 

automatic.  

Note:  When archiving to a network folder it is important to monitor the status bar for the current state of 
archiving.  If a network failure occurs the icon in the status bar changes to show a red cross.  If a failure occurs 

contact your system administrator immediately.  An archive failure will not prevent you from continuing with the 

recording. 

If the chosen archive method is CD/DVD or Removable disk, archiving is started manually - usually at the end of 

the day’s recording. 

If you configured FTR Reporter to archive sealed recordings to CD/DVD the manual archive process will create 

separate CD/DVD’s for your sealed recordings.  If you archive public recordings and sealed recordings to 

CD/DVD, two disc-burning procedures start - sealing to CD/DVD occurs first, followed by Archiving to CD/DVD. 

Manual archiving controls are available from the Recorder Bar as illustrated in the following images. 

Recorder Bar with sealing disabled while archiving to network. 

 

Recorder Bar with sealing enabled but archiving and sealing to network. 

 

Recorder Bar with sealing enabled and CD/DVD Archiving and/or Sealing to CD/DVD 

 

Recorder Bar with Removable Disk Archiving 

 

Note:  Sealing is only available if you configured FTR Reporter Sealing Options. 
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Sealing To CD/DVD 
If you have set your archive method to CD/DVD or Network, sealing can be enabled and configured.  If you set 

your sealing method to CD/DVD, the process for archiving sealed recordings is similar to archiving public 

recordings to CD/DVD.  If your sealing method is network, no user action is required - sealing is automatic. 

To seal to CD/DVD: 

1. Stop recording and close all log sheets. 

2. Insert a blank CD or DVD. 

3. Do one of the following: 

a. From the Tools>Options menu click Archive or  

b. From the Recorder bar, click . 

4. If you did not close your log sheets at the start, a message is displayed.  If you wish to proceed with 

archiving, click Yes to close log sheets. 

5. From the Archive Sealed Recordings dialog box, observe that the Available list shows all sealed 

recordings that are yet to be saved to CD/DVD.  

 

6. If all sealed recordings can fit on the available disc they are automatically selected and are displayed in the 

Pending box.  If not, it is necessary to manually select recordings.  As you select a recording, it is added to 

the Pending box.  If you select too many recordings, a warning message is displayed. 

7. When you have selected all the required recordings, click Start. 

8. Observe that the pending sealed recordings are saved to disc.  Respond to confirmation messages as required. 

9. Repeat this process until all sealed recordings are saved to CD/DVD. 

10. When all sealed recordings are saved to CD/DVD the dialog box closes. 

If you are also archiving to CD/DVD, the Archive to CD/DVD dialog box is displayed. 

See Archiving to CD/DVD in the next section. 
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Archiving to CD/DVD 
CD/DVD archiving is a manual process.  The drive to be used for CD archiving is configured in Archive Options.  

See Changing Archive and Backup Options earlier in this guide. 

To archive to CD/DVD archiving: 

1. Stop recording and close all log sheets. 

2. Do one of the following: 

a. From the Tools>Options menu click Archive or  

b. From the Recorder bar, click . 

3. If you did not close your log sheets at the start, a message is displayed.  If you wish to proceed with 

archiving, click Yes to close log sheets. 

4. From the Archive to CD/DVD dialog box, observe that the Available list shows all recordings that are yet to 

be archived. 

 

5. Insert a blank CD or DVD and observe that the Pending list is automatically updated with a list of recordings 

that will be saved to disc. 

6. Click Start. 

7. Observe that the pending recordings are saved to disc.  Respond to confirmation messages as required. 

8. Repeat this process until all recordings are safely archived. 
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Archiving to Removable Disk 
Removable archiving is a manual process and is configured in Archiving Options. 

To archive to Removable disk: 

1. Close all log sheets. 

2. Do one of the following: 

a. From the Tools>Options menu click Archive or  

b. From the Recorder bar, click  

3. If you did not close your log sheets at the start, a message is displayed.  If you wish to proceed with 

archiving, click Yes to close all log sheets. 

4. From the Archive to Removable dialog box, observe that the Available list shows all recordings that are 

yet to be archived. 

 

5. Connect your removable disk and select it from the Drive list. 

6. Observe that the Pending list is automatically updated with a list of recordings that will be saved to disk. 

7. Click Start. 

8. Observe that the pending recordings are saved to disk and respond to confirmation messages as required. 

9. Repeat this process until all recordings are safely archived. 
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Printing 
You can print Log Sheets, Quick Notes or the Word List. 

Printing Log Sheets 
You can print a log sheet or selection of notes from the active log sheet.  Prior to printing you can adjust the way 
the printed page appears by changing the page setup.  You can also preview the print job on screen before 

printing. 

If you wish to print multiple log sheets see Open, Copy, Print or Delete Multiple Log Sheets earlier in this guide. 

To print the active log sheet: 

1. To print a selection from the active log sheet, select one or more rows otherwise skip this step. 

2. Click the Menu button , point to File and click Print or click the Print button . 

3. From the Print dialog box, do one or more of the following: 

a. Select the Heading Page check box to print the contents of the Description, Date and Location fields. 

b. Select the Log Notes option to print notes and then select All or Selection.  

Note:  The Selection option is only available if you previously selected a range of notes.

 

4. Select a printer, number of copies and collation option, as required and click OK. 
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Page Setup 

When printing notes, it may be necessary to change the page setup.  Page setup controls the margins, headers 

and footers. 

To change page setup: 

1. Click the Menu button , point to File and click Page Setup. 

2. In the General tab, select margins and heading page options.

 

3. Set margins, as required. 

4. Heading page options control what is printed when you choose to print heading pages in any print job.  If you 

only print log notes, these options do not apply. 

• Select Do not print header on the first page to prevent any header information 
being printed on the first heading page. 

• Select Do not print footer on the first page to prevent any footer information being 
printed on the first heading page. 

• Select Print separate heading page if you want to print your heading information 
separate from the log notes. 
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5. From the Header or Footer tabs, directly key in your own text or use the predefined Include buttons.  To 

generate a new line (to a maximum of 10) press SHIFT+ENTER.  Use the scroll bars to reveal any hidden text.  

 
 

Header and footer information can be aligned left, centre or right.  Click the alignment box you wish to use 

and insert the required information using the Include buttons or by typing your own text. 

Include buttons 

Click  to include the first line of the description field - inserts <DESCRIPTION> 

Click  to include the location name - inserts <LOCATION> 

Click  to include the recording date - <DATE> 

Click  to include the page number - <PAGE> 

Click  to include the total number of pages - <TOTALPAGES>  

Tip:  Pages and total pages are typically entered as Page <PAGE> of <TOTALPAGES> 

6. Click OK to save the settings. 
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Print Previewing 

Before printing you can preview the output on screen to confirm that the page setup is correct. 

To print preview: 

1. Click the Menu button , point to File and click Print Preview or click the Print Preview button  

2. From the preview window do one or more of the following: 

a. View other pages by clicking the Prev Page and Next Page buttons as required.

 
 

 

b. Click Print to print the active log sheet and close all print dialog boxes. 

c. Click Close to exit the Print Preview window. 
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Printing Quick Notes and the Word List 
If you have limited screen space and you do not want to keep the quick notes window open, you can print your 

quick notes and display them in a prominent position near your computer. 

You may also need to print the Word List that is associated with your log sheet. 

Printing Quick Notes 

Printing quick notes is a two-step process that requires you to copy the quick notes to the clipboard and then use 

your text editor or word processor of choice to paste, and print the document. 

To print quick notes: 

1. Click the Menu button , point to Tools and click Quick Notes or click the Quick Notes button . 

2. From the Quick Notes window, click Copy. 

3. Using your own text editor or word processor, create a new document and paste the contents of the clipboard. 

4. When the document is open, make any changes you require and then print the file. 

Printing the Word List 

Printing the word list is a two-step process that requires you to copy the list to the clipboard and then use your 

text editor or word processor of choice to paste, and print the document. 

To print quick notes: 

1. Click the Menu button , point to Tools and click Word List or click the Word List button . 

2. From the Word List window, click Copy. 

3. Using your own text editor or word processor, create a new document and paste the contents of the clipboard. 

4. When the document is open, make any changes you require and then print. 
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Keyboard Shortcuts  
Keyboard shortcuts are available in the following categories: 

• General Shortcuts 

• Editing Shortcuts 

• Navigation Shortcuts 

• Selection Shortcuts 

General Keyboard Shortcuts 
Use these shortcuts for the main functions of FTR Reporter. 

To Press 

Show menu ALT or F10 

Create a new log sheet ALT + F12  (edit mode only) 

Find Text 

Find Next* 

CTRL + F3 

ALT + F3 

Link  F9 

Open a log sheet  F3 

Open shortcut menu  SHIFT + F10 

Open program Options ALT + ENTER 

Print log sheet CTRL + SHIFT + F12 

Quit program\close log 
sheet 

ALT + F4 

Save Copy As F12 

Toggle Edit/Read-only mode SHIFT + F12 
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Editing Keyboard Shortcuts 
Use these shortcuts to enter notes and to edit existing notes.  

Note:  Listed shortcuts apply to edit mode only unless otherwise noted.  

 

To  Press 

Create a new empty log note CTRL + ENTER 

Enter a new line SHIFT + ENTER 

Bold selection  CTRL + B 

Italicize selection  CTRL + I 

Underline selection CTRL + U 

Copy selection in Edit mode or 
Copy selection in read-only mode if Accessibility 
is enabled or 
Copy current field in read-only mode if 
accessibility is disabled 

CTRL + C 

Cut selection  CTRL + X 

Paste  CTRL + V 

Delete character to the right DELETE 

Delete character to the left BACKSPACE 

Add selection to quick notes SHIFT + F3 

Add selection to word list SHIFT + F4 

Undo CTRL + Z 

Redo CTRL + Y 

 

Selection Keyboard Shortcuts 
Most of the following selection shortcuts apply to a log sheet in edit mode.  Those that also apply to read-only 

mode are marked. 

To  Press 

Select field contents F2 

Select character to left SHIFT + Left 

Select character to right  SHIFT + Right 

Select word to left CTRL + SHIFT + Left 

Select word to right  CTRL + SHIFT + Right 

Select next line.  SHIFT + Down 

Select previous line. SHIFT + Up 

Select to end of line  SHIFT + END 

Select to beginning of line  SHIFT + HOME 

*Select current log note or add current log note to selection  CTRL + SPACEBAR 

*Select all notes between the current log note and the last selected 
log note  

CTRL + SHIFT + SPACEBAR 

 

*Also available in read-only mode. 
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Navigation Keyboard Shortcuts 
Use these shortcuts to move around the log sheet. 

Note:  With Accessibility enabled, read-only navigation shortcuts behave as edit mode shortcuts. 

 

Press 
 

Edit mode or read-only mode  
with Accessibility enabled  

Read-only mode with Accessibility disabled 
 

Right Move to next character  Move to next field 

Left Move to previous character Move to previous field 

Up Move up a line in a log note field 
Move and/or scroll up a line in the description or location 
field  

Move up a field 

Down Move down a line in a log note field Move and/or scroll down a line in the description 
or location field  
Move down a field 

CTRL + Right Move to beginning of next word  No action 

CTRL + Left Move to beginning of previous word No action 

PAGE UP Scroll up a page  Scroll up a page  

PAGE DOWN  Scroll down a page  Scroll down a page  

TAB  Move to next field  Move to next field  

SHIFT + TAB Move to previous field Move to previous field 

HOME Move to beginning of the line No action 

CTRL + HOME Move to Description field  Move to Description field  

ALT + HOME Move to first Speaker Field  Move to first Speaker Field  

END Move to end of line No action 

CTRL + END  Move to last Speaker field Move to last Speaker field 

ENTER Move to last Speaker field No action 
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